How to Construct a Burnham'’s List
The example we will use is the southern constellation of Pisces Austrinus.

Double and Multiple Stars

Here’s the page from Burnham’s with the entries for double and multiple stars:

: ] PISCES AUSTRINUSJ

LIST OF DOUBLE AND MULTIPLE STARS

NAME DIST PA YR  MAGS NOTES RA & DEC
6 6.8 59|27 |6~ 13 | (B1009) Spect AO 2129253410
rﬂGIB 0.2)101139 |8%- 9 |PA dec, spect F8 2146283552
h3059 | 25.2§253|30 | 7%~ 10%|Relfix, spect B9 2147952810
Bl014 2.8[145[32 |8 - 12 [Spect A0 2153753138
5311 [40.61292[19 [7 - 10 |spect KO 2156682918
48.6f227|19 | - 10%
Sth 56 [11.3| 35[35 | 7% 11 |relfix, spect FQ 2156782752
. 1.6]116(55 | 5%~ 6% | ( B276) relfiy, 2158082842
I spect B8
- BS47 2.3{294}35 |8 - 14 |spect A2 2200352718
- B549 3.6[213|59 |7 - 13 |spect KO 22G17s2608
Dawl56 | 1.3|317]59 | 7%~ 11 |PA inc, spect GO 2207613404
L B769 0.9(352(52 |7 = 8% |relfix, cpm pgiy; (220873443
i spect F2
| B557 0:31321,53 8 = B |PA dee; spect P2 2219183446
\a74 0.1 56 |7 - 8 |(h3118) spect KO; [2226682855
; 33,7|296|59 - 11 |AB unecertain
ﬁ\/s 30.4]172]52 | 4% 7% | (A240) nice cpm 2228753236
relfix pair, spect
i ; A0
18568 4.9(310]35 | 7%~ 13 |spect A3 2235283344
h5356 |86.6/160|51 |6%- 7 |(H VI 119) wide cpm|22370s2836
h5356b | 3.2| 67|59 7 - 8 |pair, spect GO,F5;
i BC PA inc.
Hd 301 | 0.2} 91|54 |7 - 7 |Binary, 27 yrs; PA |22472s3304
i dec, spect F2
h5365 | 4.8]278]33 | 7%-12% |spect A3 2249053608
: 55.6] 35(19 [ =11
')’ 4.3|262|57 |4%- 8% | (h5367) PA slow 2249853308
dec, spect AO
5 5.0(244(53 | 4%~ 10 | (Hwe 91) cpm pair, |22532s3248
. slight PA inc,
. spect gG8, G3
a 30.0| 36|00 |1 - 14 |FOMALHAUT, Spect A3|22549s2953
: Optical (%)
[hs371 | 9.0(343|50 | 7% 9 |relfix, spect GO  [2255152622
1483

Most of these stars are to be found in the Washington Double Star Catalogue (WDS) or
the Bright Star Catalogue. You will need these catalogues on hand. The first thing to
tackle are the entries likely to appear in the WDS. These are pretty much all the entries
that do not have either a Bayer classification (single Greek letter) or a Flamsteed number
(an integer number). In this case we have one Flamsteed entry (6) and 5 Bayer entries
M, B, ¥, 0, ¢). In order to use the WDS, the notation used by Burnham needs to be



translated into that used in the WDS. The table below will help (latest version available
on-line).

Observer Burnham ID WDS Name ID Example
F.G.W.Struve b3 STF ¥ 265 = 5TF265
0.Struve )3 STT OF 1265 = 5TT1265
J.Herschel h HJ h 45 = HJ45
J.Dunlop A DUN AQ3=DUNSS
S.W.Burnham B BU [ 89 = BU8S
R.G.Aitken A A A BB = ABB

Alvan Clark AC AC AC 141 = AC144
R.A.Rossiter Rst RST Rst 761 = RST761
F.Argelander Arg ARG Arg 62 = ARGE2
H.A Howe Hwe HWE Hwe B = HWEB
Cordoba Obswt Cor Coo Cor258 = CO0258
T.E.E=pin Es ES Es 7 = ES7

W.J Hussey Hu HU Hu 81 = HUB1
R.T.Innes I I | 66 = 166

T.J.J.See A SEE A& 113 = SEE113
C.Rumker Rmik

G.W.Hough Hao HO Ho 72 = HO72
W.H.van den Bos B B BE =86
E.5.Holden Hn, Hid HM, HLD Hn B3 = HNB3, Hid 11 = HLD11
G.P.Kuiper Kui V] Kui 5 = KUIS
J.South 5 s 597 =547

7 Sei SEl Sei 37 = SEI37
77 J J J 431 = J431

77 a DA d B =DAWS

Y Gls 5L Gls 159 = GLIT69
Y R R R121=R121
Yi'L Sir SLR Slr 22 = 5LR22
e @ FIM @ 37 = FIN3Y
KL Hd HOO Hd 241 = HDDO241
Y Cp CROD Cp 15 =CPO15
Y hld LD Mid1 = MLO1
T MZ MNZ0 NZ23 = NZ023
Yi'E Hrg HRG Hrg 19 = HRG19

The first thing to do is create an empty plan document in AstroPlanner. You can also
reuse an existing one by deleting all the entries. Select the Planning tab.



New File [0 Objects]

[ observing l Field of View I Sky [..mum_l
(1] Name Type A Dec Obs | Mag Mag2 | Separation Size Const | Catalogue Spect
4 5 ) e
[ MewObject ) Delete Object | Add Special... |-$-] Show catalogue.... |—$—~] | Select from catzlogue... }-—3-1
S
| Delete... }-—3-1
1D: Right Ascension: Type: Magnitude: Notes:
h m 5

_( Lockup ID... \_ aﬁll Spectral: Magnitude:
| S

Size:z Separation:

Mame: Declination:

Show Field of View

' Lookup Mame... gﬂll
- SRR R .

Click the Lookup ID... button. In the dialog, enter the double star IDs separated by
commas and/or new lines. Note below that we used the table above to convert the entries

where necessary. Click Lookup.

Lookup Items

Paste or type item//'s, separated by new lines, tabs, and/or commas

|B1013,HIJ3059,B1014,HI5311,5TNSE,B547, B549 DAW156
| BU7£9,B557,SEE474,B568 HI53156 HDO301  HIS365,HIS371

Prefix: Suffix:

beainning and end of each itam abo

{ Cancel Y | Lookup \
e ——

Select only the WDS catalogue entry for speed and to avoid finding spurious objects from

elsewhere.



Catalogue Search

Search far:

|
h

to search

[

Terzan Cluster Catalogue "
Trumnpler Catalogue

Tycho Stellar Catalogue

UGC Catalogue

LUSNO Meglected Doubles A Catalogue

;_i USNO Meglected Doubles B Catalogue

[T USNQ Neglectad Doubles C Catalogue
‘Washington Double Star Cataloegue

[T Xz80p Zadiacal Catalogue m

E Zodiacal Catalogue v

[ Selectal [ Select None )
e e

| Select catalogues containing... l-ﬁﬁ-i

|| Cross-index ID fieids

In the results window, you’ll probably want to click the Add All button to add all the
found entries.

i 8006 Search Results

Search {1s] Name Type RA Dec Magnitude | Catalogue Description
B1D13 WOS21492-3.8B1013 Dbl 21h 43m -35738' 8.3 Washington 1st Obs: 1927(0.2",132deg),Last Obs: 1977(0.17,121d
HJ3059 WDS21508-2.. H13059 Dbl 21h51m -27°56' A Washington ADS15365, 15t Obs: 1830(15.07,258deg),Last Obs: 19
B1O14 WOS21567-3..81014 Dbl 21h 57m -31723' 79 Washington 1st Obs: 1928(2.7",144deg),Last Obs: 1960(2.4" 143d
HJ5311 WDS21595-2._HIZ311 Dbl 22h O0m -25703" F ] Washington 1st Obs: 1919({48.6",227deg),Last Obs: 1919(48.67,22
HJS311 WDS21595-2_HI5311 Dbl 22h 00m -25703' T Washington 1st Obs: 1834(30.0",29Bdeg),Last Obs: 1919(40.67,29
STNSE WDS21596-2.. STMSE Dbl 22h O0m -27°38' o | Washington ADS5155083, 1st Obs: 1878(12.17,38deg),Last Obs: 199
BS47 WDS22031-2.B547 Dbl 22h 03m -27°03' 7B Washington ADS15570, 1st Obs: 1925(2.4" 295deg),Last Ob: 32
B549 WDS22045-2_B549 Dbl 22h 05m -25°53' 7a Washington ADS155%2, 1st Obs: 1926(3.47 208deg),Last Obs: 195
DAWISE WOS22105-3_DAW15E Dbl 22h 11m -33°50" A Washington 1st Obs: 1922(1.3",298deg),Last Obs: 1921(1.6",331d
BU7EZ WDS22116-3.BU7ES Dbl 22h12m -34728" A Washington 1st Obs: 1879(0.6",349deg) Last Obs: 1991(0.8", 358d
BS57 WDS22220-3_B557 Dbl 22h 22m -347371' 74 Washington 1st Obs: 1926(0.3",344deg),Last Obs: 1992(0.27,292d
SEE474 WDS22294-2. SEE4T4 Dbl 22h 29m -28740" Fa | Washington ADS15378, 1st Obs: 1896(0.6",290deg) Last Obs: 1955(0.37,32
B5E68 WOS22380-3..B56E Dbl 22h 38m -33°28' 76 Washington 15t Obs: 1927(4.9",310deg),Last Obs: 1935(5.0",310d
HDO301 WDS22500-3.. HDO301 Dbl 22h 50m -32748' 6.3 Washington 1st Obs: 1897(0.4",90deg),Last Obs: 1996(0.37,149de
HJS365 WODS22518-3._HI5365 Dbl 22h 52m -35°53' e Washington 1st Obs: 1919(55.6",35deg),Last Obs: 1991(55.2" 36d
HJS365 WDS22518-3_HI5385 Dbl 22h 52m -35°53' I5 Washington 1st Obs: 1835(2.5",27 2deg) Last Obs: 1991(4.97 276d
HJ5371 WDS22578-2.HI5371 Dbl 22h 58m -26°07" T Washington ADS16400, 1st Obs: 1834(5.07,346deg) Last Obs: 199
- . ] e
I Slew to Object [ Select Non-duplicates | Add Selected m

[__: Keep window open 17 objects found P
“

The entries then appear in the plan document.



8Q0e New File [17 Objects] y

[ Observing l Field of Wiew mkm_l

o Name | Type | RA | Dec | Obs Mag  Mag2 | Separation | Size | Const | Catalogue | Spect
| WDS214923538 B1013 Dbl 21h 49m 135 -35"38"19" 8.9 5.0 (18] Psf Washington  F&/7V
| WDS21508-2756 HJ3059 Dbl 21h 50m 465 -27'55'57" 7.5 10.6 25.3 Psa Washington ~ BE.5W
WDS21567-3123 B1014 Dbl 21h 56m 3%s -31°23'23" 79 12.2 2.4 Psf Washington Al
| WDS21595-2903  HJS31 Dbl 21h 59m 315 -29°03'24" 7. 10.2 488 Psa Washington
WDS21595-2803  HI5311 Dbl 21h 59m 315 -29°03'24" [l 10.6 406 Psi Washington  GB/KOH
| WDS21596-2738 STNSE Dbl 21h 59m 355 -27'37'50" 73 10.5 11.4 Psa Washington F2v
WDS22031-2703 BS47 Dbl 22h 03m 0%s -27°03'04" 78 142 2.1 Psf Washington  ASVm
| WDS22045-2553  BS43 Dbl 22h 04m 30s -25°53'00" 7.0 13.0 7 Psa Washington Gan
WD522105-3350 DAWI15E Dbl 22h 10m 325 -33°49'39" .7 1.1 1.6 Psi Washington G3v
| WDS22116-3428  BU789 Dbl 22h 11m 385 -34'27'54" 7. 8.2 0.8 Psa Washington
WDS522220-3431 BSSY Dbl 22h 21m 585 -34'31"13" 74 7.5 0.2 Psf Washington  F3/5V
| WDS22294-2840 SEE474 Dbl 22h 29m 265 -28'39'34" 78 8.2 0.3 Psa Washington K2
WDS22380-3328 BSGE Dbl 22h 38m 025 -33°28"13" 76 13.4 5.0 Psi Washington A
| WDS22500-3248 HDO3M Dbl 22h 49m 595 -32°48'19" 6.3 6.5 0.3 Psa Washington FOV+F3V
WDS22518-3553  HI5365 Dbl 22h 51m 465 -35'53'19" 7.5 1.3 55.2 Psf Washington
| WDS22518-3553  HJ5385 Dbl 22h 51m 465 -35'53'19" 7.5 10.2 45 Psé ‘Washington Al
| WDS22578-2606 HJS3T Dbl 22h 57m 485 -26'06'30" .7 9.2 91 PsA Washington Gav
<€ 3 I
!f Mew Object \ f Delete Object \ | Add Special... }-g-] Show catalogue.... |—G—~] | Select from catzlogue... |--3-i
| Delete... |--3-i
1D: Right Ascension: Type: Magnitude: Notes:
WD522578-2606 22 h |57 |m 48 s Dbl 7.7 ADS16400, 1st Obs: 1834(5.0", 346deg),Last Obs:
1994(9.1",343deg),#0bs:23,Dur-26 16395
_,f Lockup ID... \_ E’ﬁll Spectral: Magnitude:
et G3V 9.2
Mame: Declination: Size: Separation:
15371 28 sTes 'faa ] [ | a1
( Lookup Neme.. ) [ a1 (" Show Field of View
— —

4

Click in the blank area underneath the last entry in order to deselect any selected entry.
Click the Lookup ID... button again. This time we want to find the Bayer and Flamsteed
entries. You can either enter them as “6 PsA, Delta PSA” etc. or use the shortcut shown
below using the Suffix field (note the space before “PsA”).

Lookup Items

Paste or type item/'s, separated by new lines, tabs, and/or commas

6,eta,beta,gamma delta alpha

Prefix: Suffix:

This time select only the Bright Star Catalogue for searching (to avoid lots of duplicates).



8086

Search Results

Search (8] Name Type Ra Dec Magnitude | Catalogue

6 PsA HREZ310 6 PsA Dbl 21h 32m -33'57" 6.0 Bright SADZ213078,

eta PsA HRE31Z6 Eta PsA Dbl 22h 01m -28°27" 5.4 Bright SAD130822,
beta PsA HRB576 Bet PsA Mult 22h 32m -32°27' 43 Bright SADZ213883,
gamma PsA HREEZS Gam PsA Dbl 22h 53m -32'53' 45 Bright SADZ214153,
delta PsA HRE7Z0 Del PsA Dbl 22h 56m -32'32' 42 Bright SADZ14183,
alpha PsA HREB72E Alp PsA Star 22h 58m -29737" 1.2 Bright SAD191524,

B : 3
SRR Slew to Object [ Select Non-duplicates |

| Keep window open

HDZ204B54, 6 PsA
HD209014, Eta PsA, 12 PsA
HDZ21333E, Bet PsA, 17 PsA
HD216338, Gam PsA, 22 PsA
HDZ216763, Del PsA, 23 PsA
HDZ216358, Alp PsA, 24 PsA

Add Selected @

Description

& objects found

4

Using the Add All button adds these to the end of the list. Below shows the final list,
reordered by dragging rows to reflect the order of the original Burnham list.

ece

New File [23 Objects]

[ opserving | Field of view | sky it
] (L] Name Type A Dec Obs | Mag Mag2 Separation Size Const | Catalogue Spect |
REZ30 6 PsA Dbl 21h 32m 15s -33'56'41" 6.0 133 6.8 PsA Bright
WDG21492-3538 B1013 Dbl 21h 43m 13s -35°38"138" 8.9 9.0 o1 PsA Washington  F&/7V
| WD521508-2756 HJ3059 Dbl 21h 50m 46s -27°'55'57" [A7 10.8 25.3 PsA Washington  BB.3V
| WDS21567-3123  B1014 Dbl 21h 56m 33s -31°23'23" 7.9 12.2 2.4 PsA ‘Washington AD
| WDS21595-2903  HJ531 Dbl 21h 58m 31s -29°03'24" [ 10.2 486 PsA ‘Washington
| WDS21595-2903  HJ5311 Dbl 21h 59m 31s -29°03'24" F 10.8 40.8 PsA ‘Washington  GB/KOHI
WDS21596-2738  STNSE Dbl 21h 53m 355 -27°37'50" 73 10.5 1.4 PsA ‘Washington F2v
RE1BE Eta PsA Dbl 22h ODm 50s -28°27'13" 5.4 6.4 1.9 PsA Bright:
| WDS22031-2703 B547 Dbl 22h 03m 09s -27°03'04" ] 142 2.1 PsA Washington ~ ASVm
| WDS22045-2553 BS549 Dbl 22h 04m 30s -25°53'00" 7.0 13.0 a7 PsA ‘Washington GBil
| WDS22105-3330 DAW1S6E Dbl 22h 10m 32s -33°49'33" rs 111 1.6 PsA Washington ~ G3V
| WDSZ2116-3428 BUTEZ Dbl 22h 11m 38s -34'27'54" 7.1 B.2 0.8 PsA ‘Washington
| WDS22220-3431 BS57 Dbl 22h 2Tm 58s -34'31"13" 74 7.5 0.z PsA Washington  F3/5V
| WOS22234-2840 SEE4T4 Dbl 22h 29m 265 -28'39'34" 79 B.2 0.3 PsA ‘Washington K2H
Beta PsA Mult 22h 3Tm 30s -32°20'46" 43 7.8 303 PsA Bright
| BEed Dbl 22h 38m 025 -33°28"13" 76 13.4 5.0 PsA ‘Washington A
| HDO301 Dbl 22h 49m 595 -32°43'713" 6.3 6.3 0.3 PsA ‘Washington FOW+F3V
| HJ536% Dbl 22h 51m 465 -35"33'13" 75 1.3 55.2 PsA ‘Washington
HJ5365 Dbl 22h 5Tm 465 -35"33'13" 7 10.9 4.9 PsA ‘Washington A
Gamma PsA Dbl 22h 52m 325 -32'52'32" 4.5 8.1 42 PsA Bright
Delta PsA Dbl 22h 55m 57s -32'32'23" 4.2 9.2 5.2 PsA Bright
Alpha PsA Star 22h 57m 39s -29°37'20" 1.2 PsA Bright
HJ5371 Dbl 22h 57m 48s -26°06'30" [s 9.2 9.1 PsA Washington ~ G3V
. - ] 3|
[ NewObject ) Delete Object [Add Special.. [§) [ Show catalague.. [#] [ Select from catalogue... ]
[ Delete... }-e-i
1D Right Ascension: Type: Magnitude:  Notes:
h m 5
( Lookup 1D... \ E Al Spectral: Magnitude:
.
Name: Declination: Size: Separation:

()

Show Field of Wiew

P4

Then use the Save As text... command in the File menu and save the file with the special
“Burnham_xxx_y.txt” file name, where xxx is the constellation abbreviation and y is “D”



for double/multiple stars, “V” for variable stars and “C” for Clusters, etc. In this case, the
name must be “Burnham PsA_D.txt”. Case is not important, spelling is.

Save

Save As: Burnham_PSA_D.txt

Where: | @ Desktop I-‘?"! B

€ cancel ) G"Smnr-’

In the plan information dialog, add some descriptive text and your name.

Plan Information

— Description

Burnham’s Celestial Handbook
Pisces Austrinus
Double and Multiple Stars

Creator's Name: | Paul Rodman

Now the text file is saved, go to the plan upload page in your browser. Click the Choose
File button and select the file you just created.

Directory listing

eno
: @ @ i http://www.ilangainc.com/astroplanner /plans/ @ Q- Google ) .:.

- [0 Version MacCentral Macintouch DealMac MacFixlt DCRP PowerPage Rumours ATAT AstroMart »

AstroPlanner Plan Upload Page

MName Size Kind Last Modified

Upload file: [ Choose File ] = Burnham_PSA_D.txt

Upload ) ( Clear |

Click on the Browse... button above to select the Plan file on your hard disk. Then click the Upload button to send the file to
the list above.

Mote that only valid Plan files will be accepted. All others will be deleted.

A valid Plan file is created by using the Save As Text... command from the File menu in AstroPlanner (V1.1.1 or after).

When you've finished, click here to add your plan/s to the list.
If you would also like to announce your posting to the AstroPlanner Yahoo Group, click here instead.

/]

Click the Upload button to upload the file to the “staging area”.



|r6 &ls) Directory listing
|

-D P + | § http://www.ilangainc.com:80/ilanga/astroplanner/plar® = Qr Coogle ) ..

[0 Wersion MacCentral Macintouch DealMac MacFixit DCRP PowerPage Rumours ATAT AstroMart »

AstroPlanner Plan Upload Page

Name Size Kind Last Modified

D Burnham_PSA_D.txt 3K document 05/05/03, 17:02

[ erempm———{ Y
Upload file: | Choose File | no file selected
| Uplnad\ [ Clear |

Click on the Browse... button above to select the Plan file on your hard disk. Then click the Upload button to send the file to
the list above.

Mote that only valid Plan files will be accepted. All others will be deleted.

A valid Plan file is created by using the Save As Text... command from the File menu in AstroPlanner (V1.1.1 or after).

When you've finished, click here to add your plan/s to the list.
If you would also like to announce your posting to the AstroPlanner Yahoo Group, click here instead.

-

Repeat this for any other files you may have created, and then click the “when you’ve
finished, click here” link. Voila. You’re done.

Variable Stars

Variable stars are typically in the GCVS Catalogue, unless they have a Bayer or
Flamsteed designation in which case use the Bright Star Catalogue.

The Variable Star list for Pisces Austrinus is shown on the next page. Use the same
techniques as above to find them. Here’s the Lookup dialog for the stars:

Lookup Items

Paste or type item/'s, separated by new lines, tabs, and/or commas

BEFcwR

ST

Prefix: Suffix:
PsA|

) Lookup )
e

Cancel



PISCES AUSTRINUS

LIST OF VARIABLE STARS

NAME MagVar PER NOTES RA & DEC
T | 4.7--5.0 |7.975| Cepheid, spect FO 2300783501
R |8.5--12..| 293 |LPV. Spect M3e 2215252951
S |8.3--13..| 272 |LPV. Spect M3e--MbSe 22009s2818
vV |8.0--9.. 148 Semi-reg; spect M5 2252652953
RV |19.0--12.. | 361 LPV. 2135852726
RX [9.0--10.. | 366 Semi-reg 2210352731
RY |8.8--13.. | 223 |LPV. 2144553626
ST |8.5--12.. LPV. 2251553440
LIST OF STAR CLUSTERS, NEBULAE AND GALAXIES
NGC OTH TYPE SUMMARY DESCRIPTION RA & DEC
-——- |1.5135 | “©O.| s0?/Pec; 13.1; 0.9' x 0.8" |21453s3512
F,pL,R
7135 .| s0; 13.0; 0.9' x 0.7 2146853507
pB,pL,1E, vgbM
7154 | 1;:13.5; 0.8" x 0.5’ 2152453503
B,pL,1E, glbm; central bar
7172 .| Sa; 12.9; 1.6'x 0.6' 21591s3207
pB,pL,1E,gbM; ‘'nearly edge-on .
with dark equatorial band;
Compact trio of E galaxies
7173, 7174, 7176 lies 7'
to south.
=== |1 5156 | "Ek{ SR 18.9¢ 1.0% x 0.5" 2200453402
PF,pS,mE
7314 ~8.| Sb/Sc; 11.9; 3.5' x 1,5' 22330s2618
cF,L,mE,vlbM, elong N-S
7361 ~&-| sb; 12.8; 3.0' x 1.0' 2239553019
F,pL,mE,vglbM. Nearly edge-
on spiral, elong N-S
-~== |I.5269 | ©-| s0; 13.1; 1.3' x 0.5"' 2255053618
vF,pS,mE, spindle~shape ]
-=-= [1.5271 | ~&-] s07; 12.6; 2.0' x 0.8' 2255353401
pF,pS,mE, cbM ; '
1484

The resulting list, including © PsA from the Bright Star Catalogue is shown here:



8006 New File [8 Objects]
! Observing [ Field of View malmnm.l

e = s = 'h-p.g = e = o e

| Mag2 | Separation | Size | Const | Catalogue | Spect

ag
HRE7&7 Pi PsA Star 23h 03m 30s -34744'58" 51 PsA Bright
RPsA Var Star  22h 18m 00s -29°36"15" 83 147 PsA GCVS M3{e-Msle
SPsA Var Star  22h 03m 465 -28°03'08" 8.0 14.5 PsA GCVS M3e-MSlle
V PsA Var Star  22h 55m 20s -29°36'42" 9.3 10.5 PsA GCVS VB
RV PsA Var Star  21h 38m 415 -27°12'08" 10.5 13.0 PsA GCVS
RY PsA Var Star  22h 13m 10s -27°16'14" 10.5 1.5 PsA GCVS Me
RY PsA Var Star  21h 47m 315 -36711'46" 88 14.0 PsA GCVS Me
ST PsA Var Star  22h 54m 19s -34723'31" 45 13.0 PsA GCVS Me
|« € 5 ) vl |
(" NewoObject Delete Object [ Add Special.. [ | Show catalogue... [$) [ select from catalogue... i+
S -
| Delete... |—$—1
1D: Right Ascension: Type: Magnitude: Notes:
h m 5
@ g Al Spectral: Magnitude:
Mame: Declination: Size: Separation:
' Lookup Name... '} EAII Show Field of View
N ——

This would be saved and uploaded as “Burnham PsA V.txt”.

Star Clusters, Nebulae and Galaxies

These are quite straightforward. In most cases the NGC number is given in the NGC
column. Note the Prefix shortcut below.

Lookup Items

Paste or type item//'s, separated by new lines, tabs, and/or commas

7135
| 7154
vz
7314
7161

Prefix: Suffix:
NGC

Y DR i B B ERah T ah

_" Cancel Yy Lookup :
.~ N

Select the NGC catalogue only to avoid multiple duplicates.



The IDs in the OTH column (Other) can be challenging. Usually they are from the IC
Catalogue (Burnham uses “I.nnnn”’) or the Harvard Catalogue (H). However, let’s try
another method of finding an object with an unknown ID. The first entry for Pisces
Austrinus is 1.5135. Lets pretend we don’t recognize that it’s IC5135. Here’s the
procedure for tracking it down:

1.

Create a new object using the New Object button.

2. Enter the RA and Dec as given by Burnham. Burnham uses the format

“hhmmmHDDMM”, where hh is hours of RA, mmm is minutes of RA times 10
(e.g. 345 is 34.5 minutes), H is “n” for Northern hemisphere and “s” for Southern,
DD is degrees of Dec and MM is minutes of Dec. In the above case Burnham has
2145353511, which is 21h45.3m RA and —35°11° Dec.

Since Burnham uses Epoch 1950 coords, we need to convert them to Epoch 2000.

Use the Change Epoch... command from the Object menu.
Change Epoch

From: 1950.0 to 2000.0

— What to change -

|

i @ Selected object only

E C All manually entered objects

|
| \_J All cbjects

Cor ) Eomd)
=

4. To find the object in the catalogues, use the Lookup Synonyms... command

from the Object menu. This finds all objects close to the given
coordinates.

eee Search Results
Search (1] Name Type A Dec Magnitude | Catalogue Description
NGCT130 NGCY130,IC5135 Galaxy 21h 48m -34'57" 129 AP DSO IC5135, Rating:FR
IC5135 IC5135 Galaxy 21h 48m -34°57" 123 IC wF, pL, R; = 7130
NGCT130 NGCT130 Galaxy 21h 48m -34'57" NGC B, 5, R, gloM; = IC 5135
PGCET7387 PGCET3EY Galaxy 21h 48m -34°57" 129 PGC Type:5,NGC7130,IC5135,E50403-32 MCG-6-47-15,IRAS.
PGCE7401 PGCET401 Galaxy 21h 48m -34'57" 16.1 PGC Type:,ES0403-33
SACEI41 NGC 7130 Galaxy 21h 48m -34°57" 121 SAC DSO IC 5135, NGC:pB,5,R,glbM, 5B:12.7, U2K:383, Sky2K:23,
Star 21h 48m -34°57" 93.0 Tycho
«F ] I e

Search complete

b Y =
hject f Select Non-dupficates Add Selected m

: Keep window open 7 objects found

5. Choose the applicable object and add it to the list.
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